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Overview

Converting Digital Line Graph Data into MGE

The conversion of USGS Digital Line Graph (DLG) data into Intergraph’s Modular GIS Environment (MGE) is a relatively simple process of building an MGE project, importing the DLG data, assuring topology within the data, and separating the DLG data into the SDS design file format.  Each of these steps requires several intermediate steps and each must be completed successfully before continuing through the migration workflow.  The entire workflow will be outlined in this document, with the requirements and procedures for each task described in detail.  The successful completion of the entire workflow will result in an MGE project containing graphic and attribute DLG data.

This document will be broken into several sections as shown below:

Section 1.  Software Requirements – This section details the requirements for additional software available from Intergraph.  A listing of the limitations of this additional software is also included.

Section 2. DLG to Intergraph MGE Workflow Flowchart – This section will present a flowchart outlining the process necessary for migrating DLG data into MGE format.
Section 3.  SDS Project Development – This section includes a listing of the minimum SDS/FMS features required to be included in the MGE Project by category.  This listing is based on the SDS/FMS version 1.95 feature definitions.  

Section 4.  Workflow – This section outlines each of the steps identified in the migration flowchart in detail.  Optional workflows are identified and described when appropriate.

Section 1. Software Requirements

Translating DLG data into Intergraph’s Modular GIS Environment requires the use of the MGE DLG Translator (MDLG).  This is a separate product that is free from Intergraph.  It is obtainable from Intergraph’s web site.  Currently, the product is available at the following address: http://www.intergraph.com/gis/new_free.asp.  The product should be downloaded and installed on a machine that currently has Intergraph’s MGE already installed.  

The DLG translator product from Intergraph reads DLG-3 Standard or Optional files and translates them into MGE features.  The translator reads a user defined parameter file to determine which feature to assign each feature code.  In this migration, where an MGE project has been created using the SDS/FMS feature names, the parameter file points to each corresponding SDS/FMS feature.  

This workflow is acceptable if only an unintelligent graphic representation of the data is to be created.  It does not work well for making a smooth translation to the SDS/FMS for the following reasons:

· The translator does not handle elements with multiple feature codes in a way that makes a one-to-one correlation possible within the SDS/FMS.  For example, if a road feature contains DLG feature codes identifying it as both a primary highway and a bridge, the MDLG translator allows the user to assign only ONE SDS/FMS feature code to the resulting graphic.  The translator will search the parameter file, find the first match (the bridge, for example), and assign the code based on that match.  In this case, the highway feature information would be lost.

· The translator does not have a facility for handling multiple element types with the same DLG feature code.  For example, tank features can be represented by points or by areas.  This would correspond to the tank_p SDS/FMS feature for points or the tank_c feature for an area centroid with the surrounding linework becoming the tank_b features.  The translator doesn’t allow the user to make the differentiation between point and area features in the parameter file.  This is another reason why the default workflow will not capture all the information.

· The MDLG translator also does not have any facility for updating attributes for features.  While certain attribute information (such as highway number, PLSS section number, county fips code, etc.) is stored within the DLG, the parameter file has no facility for allowing the user to assign this information to a particular table and column within the SDS/FMS.  

· The MDLG translator does not work well with features that span multiple categories.  In many instances, SDS/FMS features from several different categories will exist in a single DLG file.  For example, the Boundaries DLG may contain data from the cddod, famgt, bdjur, and imrec categories. The migration workflow provided has been modified to address this limitation.

The workflow that has been developed addresses as many of these limitations as possible.  Several work-arounds have been included in the workflow to allow the MDLG translator to migrate the DLG data into MGE using the SDS/FMS requirements.  These work-arounds and the reason for them will be noted in the workflow where they occur.

Section 2.  Digital Line Graph to Intergraph MGE Workflow Flowchart

This work flow chart details the steps necessary for the successful migration of DLG data into the MGE SDS/FMS data format.  All tasks must be successfully completed in order to assure data integrity.
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Figure 1 Digital Line Graph Workflow Flowchart

Section 3.  SDS Project Development

In order to successfully complete the DLG migration into MGE using the SDS/FMS format, an MGE project will need to be created or edited to include specific SDS features.  Using the SDS/FMS Generator tool, a RIS Batch File can be created to build these features, their associated attribute tables within an MGE project, necessary domain tables, and the relationships between the attribute tables as well as the domains.

Below is a series of tables that outline the minimum features required for the successful migration of DLG data into MGE.  A filter should always be used, which can be created using the SDS Filter Maker. 
DLG Boundaries

The DLG Boundaries category contains graphics outlining political and cultural boundaries. The features outlined in the following tables represent the minimum named features in the MGE project.  If any of these features are excluded from the project, there is a possibility that some DLG features will not be able to be separated into the resulting SDS/FMS required design files.  Any features that are in addition to the features outlined in the previous tables will have no effect on the DLG migration process.

Feature Type
Major-Minor Code
MGE Feature Name

bound_bdry
090-0201
bdjur_border_other_l

bound_bdry
090-0204
bdjur_border_other_l

bound_bdry
090-0204
bdjur_border_other_l

bound_line
090-0201
bdjur_border_other_l

bound_line
090-0204
bdjur_border_other_l

bound_line
090-0204
bdjur_border_other_l

bound_centrd
092-
bdjur_county_parish_c

bound_centrd
090-0100
bdjur_district_miscellaneous_c

bound_centrd
090-0101
bdjur_municipality_c

bound_centrd
091-
bdjur_state_c

bound_centrd
090-0107
bdjur_tribal_reserve_c

bound_centrd
090-0133
bggen_structure_permanent_c

bound_centrd
090-0110
bggen_structure_permanent_c

bound_centrd
090-0108
cddod_installation_area_c

bound_centrd
090-0105
famgt_fed_govt_wildlife_mgt_c

bound_centrd
090-0134
famgt_local_govt_wildlife_mgt_c

bound_centrd
090-0131
famgt_state_govt_wildlife_mgt_c

bound_centrd
090-0104
flmgt_forest_manage_federal_c

bound_centrd
090-0132
flmgt_forest_manage_state_c

bound_point
090-0001
gdsrv_control_point_bd_tab_p

bound_centrd
090-0103
imrec_park_national_c

bound_centrd
090-0130
imrec_park_state_c

bound_centrd
090-0150
imrec_recreation_park_other_c

bound_centrd
090-0151
imrec_recreation_park_other_c

bound_centrd
090-0106
lsmgt_scenic_view_p

DLG Hydrography

The DLG Hydrography category contains information about water features.

Feature Type
Major-Minor Code
MGE Feature Name

hydro_centrd
050-0126
ehmrm_ordnance_explosive_waste_c

hydro_centrd
050-0425
fapis_fish_ladder_l

hydro_bdry
050-0425
fapis_fish_ladder_l

hydro_line
050-0425
fapis_fish_ladder_l

hydro_bdry
050-0207
flhab_vegetation_aquatic_area_b

hydro_line
050-0207
flhab_vegetation_aquatic_area_b

hydro_centrd
050-0112
fltre_species_site_c

hydro_bdry
050-0410
gelth_bedrock_b

hydro_line
050-0410
gelth_bedrock_b

hydro_centrd
050-0410
gelth_bedrock_c

hydro_centrd
050-0100
gesur_alkali_flat_c

hydro_point
050-0003
gesurfetsp

hydro_centrd
050-0122
hyczn_critical_area_c

hydro_bdry
050-0200
hyczn_shoreline_mean_high_l

hydro_line
050-0200
hyczn_shoreline_mean_high_l

hydro_bdry
050-0209
hyczn_shoreline_mean_low_l

hydro_line
050-0209
hyczn_shoreline_mean_low_l

hydro_centrd
050-0105
hyflp_flood_zone_general_c

hydro_centrd
050-0103
hyice_ice_area_c

hydro_point
055-
hysur_distance_marker_p

hydro_centrd
050-0414
hysur_ditch_aqueduct_l

hydro_centrd
050-0415
hysur_ditch_aqueduct_l

hydro_centrd
050-0417
hysur_ditch_aqueduct_l

hydro_bdry
050-0414
hysur_ditch_aqueduct_l

hydro_bdry
050-0415
hysur_ditch_aqueduct_l

hydro_bdry
050-0417
hysur_ditch_aqueduct_l

hydro_line
050-0414
hysur_ditch_aqueduct_l

hydro_line
050-0415
hysur_ditch_aqueduct_l

hydro_line
050-0417
hysur_ditch_aqueduct_l

hydro_centrd
050-0104
hysur_evaporator_area_c

hydro_centrd
050-0118
hysur_evaporator_area_c

hydro_bdry
050-0203
hysur_indefinite_shoreline_l

hydro_line
050-0203
hysur_indefinite_shoreline_l

hydro_point
050-0300
hysur_spring_p

hydro_bdry
050-0421
hysur_water_body_permanent_b

hydro_line
050-0421
hysur_water_body_permanent_b

hydro_centrd
050-0106
hysur_water_body_permanent_c

hydro_centrd
050-0116
hysur_water_body_permanent_c

hydro_centrd
050-0119
hysur_water_body_permanent_c

hydro_centrd
050-0421
hysur_water_body_permanent_c

hydro_centrd
050-0614
hysur_water_course_dry_c

hydro_bdry
050-0420
hysur_water_course_intermit_b

hydro_line
050-0420
hysur_water_course_intermit_b

hydro_centrd
050-0420
hysur_water_course_intermit_c

hydro_point
050-0304
hysur_water_geyser_p

hydro_bdry
050-0400
hysur_water_rapids_site_b

hydro_line
050-0400
hysur_water_rapids_site_b

hydro_centrd
050-0400
hysur_water_rapids_site_c

hydro_centrd
050-0401
hysur_waterfall_centerline_l

hydro_bdry
050-0401
hysur_waterfall_centerline_l

hydro_line
050-0401
hysur_waterfall_centerline_l

hydro_point
050-0004
hysurentrp

hydro_point
050-0005
hysurexitp

hydro_point
050-0001
hysursprap

hydro_bdry
050-0412
hysurwater_course_permanent_b

hydro_bdry
050-0413
hysurwater_course_permanent_b

hydro_bdry
050-0416
hysurwater_course_permanent_b

hydro_line
050-0412
hysurwater_course_permanent_b

hydro_line
050-0413
hysurwater_course_permanent_b

hydro_line
050-0416
hysurwater_course_permanent_b

hydro_centrd
050-0412
hysurwater_course_permanent_c

hydro_centrd
050-0413
hysurwater_course_permanent_c

hydro_centrd
050-0416
hysurwater_course_permanent_c

hydro_bdry
050-0205
hywet_carolina_bay_b

hydro_line
050-0205
hywet_carolina_bay_b

hydro_centrd
050-0111
hywet_wetland_c

hydro_bdry
050-0605
imcmpchbll

hydro_line
050-0605
imcmpchbll

hydro_bdry
050-0606
imcmpchbrl

hydro_line
050-0606
imcmpchbrl

hydro_centrd
050-0606
imcpm_left_channel_boundary_l

hydro_centrd
050-0605
imcpm_right_channel_boundary_l

hydro_bdry
050-0406
imfdc_dam_concrete_b

hydro_line
050-0406
imfdc_dam_concrete_b

hydro_centrd
050-0406
imfdc_dam_concrete_c

hydro_centrd
050-0409
imfdc_floodgate_l

hydro_bdry
050-0409
imfdc_floodgate_l

hydro_line
050-0409
imfdc_floodgate_l

hydro_bdry
050-0408
imfdc_floodway_b

hydro_line
050-0408
imfdc_floodway_b

hydro_centrd
050-0408
imfdc_floodway_c

hydro_centrd
050-0403
imfdc_gauging_station_p

hydro_bdry
050-0403
imfdc_gauging_station_p

hydro_line
050-0403
imfdc_gauging_station_p

hydro_point
050-0305
immac_windmill_site_b

hydro_centrd
050-0418
imwat_line_siphon_l

hydro_bdry
050-0418
imwat_line_siphon_l

hydro_line
050-0418
imwat_line_siphon_l

hydro_centrd
050-0615
imwel_well_sulphur_p

hydro_point
050-0301
imwel_well_water_non_potable_p

hydro_point
050-0302
imwel_well_water_potable_p

hydro_bdry
050-0423
lfbth_sandbar_b

hydro_line
050-0423
lfbth_sandbar_b

hydro_centrd
050-0423
lfbth_sandbar_c

hydro_centrd
050-0117
lfbth_shoal_area_c

hydro_bdry
050-0208
lfbth_sounding_p

hydro_line
050-0208
lfbth_sounding_p

hydro_bdry
050-0422
lfbth_underwater_rock_area_b

hydro_line
050-0422
lfbth_underwater_rock_area_b

hydro_centrd
050-0422
lfbth_underwater_rock_area_c

hydro_centrd
050-0120
lfhyp_void_area_c

hydro_bdry
050-0410
lftop_physiographic_area_b

hydro_line
050-0410
lftop_physiographic_area_b

hydro_centrd
050-0410
lftop_physiographic_area_c

hydro_centrd
050-0114
lftop_physiographic_c

hydro_centrd
050-0115
lftop_physiographic_c

hydro_centrd
050-0110
lsgen_mine_tailings_c

hydro_bdry
050-0424
lsmgt_disposal_area_b

hydro_line
050-0424
lsmgt_disposal_area_b

hydro_centrd
050-0424
lsmgt_disposal_area_c

hydro_centrd
050-0123
trhrb_drydock_c

hydro_bdry
050-0201
trhrb_moored_vessel_site_b

hydro_line
050-0201
trhrb_moored_vessel_site_b

hydro_bdry
050-0407
trloc_lock_site_b

hydro_line
050-0407
trloc_lock_site_b

hydro_centrd
050-0407
trloc_lock_site_c

hydro_bdry
050-0419
trmar_channel_b

hydro_line
050-0419
trmar_channel_b

hydro_centrd
050-0419
trmar_channel_c

hydro_bdry
050-0206
trmar_marine_caution_area_b

hydro_line
050-0206
trmar_marine_caution_area_b

hydro_centrd
050-0121
trnav_navigation_obstruction_c

hydro_centrd
050-0604
utgen_tunnel_centerline_l

hydro_centrd
050-0107
utinw_lagoon_c

hydro_centrd
050-0405
utwat_intake_point_p

hydro_bdry
050-0405
utwat_intake_point_p

hydro_line
050-0405
utwat_intake_point_p

hydro_centrd
050-0601
utwat_line_main_l

hydro_centrd
050-0603
utwat_line_main_l

hydro_point
050-0303
utwat_line_main_l

hydro_centrd
050-0404
utwat_pump_sta_p

hydro_bdry
050-0404
utwat_pump_sta_p

hydro_line
050-0404
utwat_pump_sta_p

hydro_centrd
050-0101
utwat_reservoir_c

hydro_centrd
050-0102
utwat_reservoir_c

hydro_centrd
050-0109
utwwt_filtration_bed_c

hydro_centrd
050-0124
utwwt_filtration_bed_c

DLG Hypsography

The DLG Hypsography category contains information about landforms.  
Feature Type
Major-Minor Code
MGE Feature Name

hypso_line
020-0612
clpcp_snow_accumulation_area_b

hypso_bdry
020-0612
clpcp_snow_accumulation_area_b

hypso_line
020-0207
hyhdb_hydrobasin_storage_b

hypso_bdry
020-0207
hyhdb_hydrobasin_storage_b

hypso_line
020-0611
lfbth_contour_depression_l

hypso_bdry
020-0611
lfbth_contour_depression_l

hypso_line
020-0610
lfbth_depth_contour_approx_l

hypso_bdry
020-0201
lfbth_depth_contour_approx_l

hypso_bdry
020-0610
lfbth_depth_contour_approx_l

hypso_line
020-0205
lfbth_depth_contour_primary_l

hypso_bdry
020-0205
lfbth_depth_contour_primary_l

hypso_bdry
020-0202
lfbth_depth_contour_supp_l

hypso_point
020-0303
lfbth_sounding_p

hypso_line
020-0200
lfhyp_elev_contour_index_l

hypso_line
020-0201
lfhyp_elev_contour_index_l

hypso_line
020-0202
lfhyp_elev_contour_index_l

hypso_bdry
020-0200
lfhyp_elev_contour_index_l

hypso_point
020-0300
lfhyp_elevation_ground_spot_p

hypso_centrd
020-0100
lfhyp_void_area_c

DLG Man Made

The DLG Man Made category contains information about the infrastructure. 

Feature Type
Major-Minor Code
MGE Feature Name

mmade_line
200-0455
bggen_structure_permanent_b

mmade_line
200-0456
bggen_structure_permanent_b

mmade_line
200-0457
bggen_structure_permanent_b

mmade_line
200-0458
bggen_structure_permanent_b

mmade_line
200-0459
bggen_structure_permanent_b

mmade_line
200-0460
bggen_structure_permanent_b

mmade_line
200-0461
bggen_structure_permanent_b

mmade_centrd
200-0101
bggen_structure_permanent_c

mmade_centrd
200-0102
bggen_structure_permanent_c

mmade_centrd
200-0103
bggen_structure_permanent_c

mmade_centrd
200-0104
bggen_structure_permanent_c

mmade_centrd
200-0124
bggen_structure_permanent_c

mmade_centrd
200-0125
bggen_structure_permanent_c

mmade_centrd
200-0162
bggen_structure_permanent_c

mmade_centrd
200-0400
bggen_structure_permanent_c

mmade_centrd
200-0402
bggen_structure_permanent_c

mmade_centrd
200-0403
bggen_structure_permanent_c

mmade_centrd
200-0405
bggen_structure_permanent_c

mmade_centrd
200-0406
bggen_structure_permanent_c

mmade_centrd
200-0407
bggen_structure_permanent_c

mmade_centrd
200-0408
bggen_structure_permanent_c

mmade_centrd
200-0409
bggen_structure_permanent_c

mmade_centrd
200-0411
bggen_structure_permanent_c

mmade_centrd
200-0412
bggen_structure_permanent_c

mmade_centrd
200-0413
bggen_structure_permanent_c

mmade_centrd
200-0414
bggen_structure_permanent_c

mmade_centrd
200-0415
bggen_structure_permanent_c

mmade_centrd
200-0416
bggen_structure_permanent_c

mmade_centrd
200-0417
bggen_structure_permanent_c

mmade_centrd
200-0418
bggen_structure_permanent_c

mmade_centrd
200-0419
bggen_structure_permanent_c

mmade_centrd
200-0422
bggen_structure_permanent_c

mmade_centrd
200-0433
bggen_structure_permanent_c

mmade_centrd
200-0455
bggen_structure_permanent_c

mmade_centrd
200-0456
bggen_structure_permanent_c

mmade_centrd
200-0457
bggen_structure_permanent_c

mmade_centrd
200-0458
bggen_structure_permanent_c

mmade_centrd
200-0459
bggen_structure_permanent_c

mmade_centrd
200-0460
bggen_structure_permanent_c

mmade_centrd
200-0461
bggen_structure_permanent_c

mmade_point
200-0100
bggen_structure_permanent_p

mmade_point
200-0400
bggen_structure_permanent_p

mmade_line
200-0400
bggen_structure_permanent_p

mmade_point
200-0400
bggen_structure_permanent_p

mmade_line
200-0402
bggen_structure_permanent_p

mmade_point
200-0402
bggen_structure_permanent_p

mmade_line
200-0403
bggen_structure_permanent_p

mmade_point
200-0403
bggen_structure_permanent_p

mmade_line
200-0405
bggen_structure_permanent_p

mmade_point
200-0405
bggen_structure_permanent_p

mmade_line
200-0406
bggen_structure_permanent_p

mmade_point
200-0406
bggen_structure_permanent_p

mmade_line
200-0407
bggen_structure_permanent_p

mmade_point
200-0407
bggen_structure_permanent_p

mmade_line
200-0408
bggen_structure_permanent_p

mmade_point
200-0408
bggen_structure_permanent_p

mmade_line
200-0409
bggen_structure_permanent_p

mmade_point
200-0409
bggen_structure_permanent_p

mmade_line
200-0411
bggen_structure_permanent_p

mmade_point
200-0411
bggen_structure_permanent_p

mmade_line
200-0412
bggen_structure_permanent_p

mmade_point
200-0412
bggen_structure_permanent_p

mmade_line
200-0413
bggen_structure_permanent_p

mmade_point
200-0413
bggen_structure_permanent_p

mmade_line
200-0414
bggen_structure_permanent_p

mmade_point
200-0414
bggen_structure_permanent_p

mmade_line
200-0415
bggen_structure_permanent_p

mmade_point
200-0415
bggen_structure_permanent_p

mmade_line
200-0416
bggen_structure_permanent_p

mmade_point
200-0416
bggen_structure_permanent_p

mmade_line
200-0417
bggen_structure_permanent_p

mmade_point
200-0417
bggen_structure_permanent_p

mmade_line
200-0418
bggen_structure_permanent_p

mmade_point
200-0418
bggen_structure_permanent_p

mmade_line
200-0419
bggen_structure_permanent_p

mmade_point
200-0419
bggen_structure_permanent_p

mmade_line
200-0422
bggen_structure_permanent_p

mmade_point
200-0422
bggen_structure_permanent_p

mmade_line
200-0433
bggen_structure_permanent_p

mmade_point
200-0433
bggen_structure_permanent_p

mmade_point
200-0455
bggen_structure_permanent_p

mmade_point
200-0456
bggen_structure_permanent_p

mmade_point
200-0457
bggen_structure_permanent_p

mmade_point
200-0458
bggen_structure_permanent_p

mmade_point
200-0459
bggen_structure_permanent_p

mmade_point
200-0460
bggen_structure_permanent_p

mmade_point
200-0461
bggen_structure_permanent_p

mmade_centrd
200-0105
bggen_structure_portable_c

mmade_point
200-0626
bggen_tower_control_p

mmade_point
200-0614
bggen_tower_fire_p

mmade_point
200-0305
bggen_tower_general_p

mmade_point
200-0625
cogen_tower_control_p

mmade_point
200-0308
crarc_cliff_dwelling_p

mmade_point
200-0301
crhst_historic_featur_national_p

mmade_line
200-0452
crhst_ruins_site_b

mmade_centrd
200-0452
crhst_ruins_site_c

mmade_point
200-0452
crhst_ruins_site_p

mmade_point
200-0618
crhst_ruins_site_p

mmade_line
200-0450
crhst_structure_standing_site_b

mmade_centrd
200-0450
crhst_structure_standing_site_c

mmade_point
200-0450
crhst_structure_standing_site_p

mmade_point
200-0311
gesub_borehole_rock_p

mmade_point
200-0302
gesur_feature_site_p

mmade_line
200-0436
hysur_river_bank_l

mmade_centrd
200-0122
imath_athletic_field_c

mmade_centrd
200-0123
imath_golf_course_c

mmade_line
200-0451
imath_swimming_pool_b

mmade_point
200-0451
imath_swimming_pool_b

mmade_centrd
200-0451
imath_swimming_pool_c

mmade_line
200-0203
imfdc_floodwall_l

mmade_line
200-0206
imgen_fence_l

mmade_point
200-0306
imgen_smokestack_chimney_p

mmade_line
200-0202
imgen_wall_l

mmade_line
200-0211
immac_coke_over_l

mmade_line
200-0200
immac_conveyor_centerline_l

mmade_line
200-0462
immac_grain_elevator_b

mmade_centrd
200-0462
immac_grain_elevator_c

mmade_point
200-0462
immac_grain_elevator_p

mmade_point
200-0310
immac_kiln_p

mmade_centrd
200-0426
immac_marine_production_site_c

mmade_line
200-0426
immac_marine_production_site_p

mmade_point
200-0426
immac_marine_production_site_p

mmade_point
200-0317
immac_windgen_p

mmade_point
200-0448
imrec_boat_ramp_b

mmade_centrd
200-0448
imrec_boat_ramp_c

mmade_line
200-0448
imrec_boat_ramp_p

mmade_point
200-0449
imrec_camping_site_b

mmade_centrd
200-0449
imrec_camping_site_c

mmade_point
200-0316
imrec_camping_site_p

mmade_line
200-0449
imrec_camping_site_p

mmade_line
200-0213
imrec_drive_in_theatre_b

mmade_centrd
200-0126
imrec_drive_in_theatre_c

mmade_line
200-0212
imrec_feat_line_l

mmade_line
200-0453
imrec_miscellaneous_b

mmade_centrd
200-0453
imrec_miscellaneous_c

mmade_point
200-0453
imrec_miscellaneous_p

mmade_line
200-0454
imrec_picnic_site_b

mmade_centrd
200-0454
imrec_picnic_site_c

mmade_point
200-0454
imrec_picnic_site_p

mmade_centrd
200-0127
imrec_racetrack_l

mmade_line
200-0214
imrec_racetrack_l

mmade_line
200-0445
imrec_recreation_misc_b

mmade_line
200-0446
imrec_recreation_misc_b

mmade_line
200-0447
imrec_recreation_misc_b

mmade_centrd
200-0120
imrec_recreation_misc_c

mmade_centrd
200-0445
imrec_recreation_misc_c

mmade_centrd
200-0446
imrec_recreation_misc_c

mmade_centrd
200-0447
imrec_recreation_misc_c

mmade_centrd
200-0140
imrec_small_craft_marina_c

mmade_centrd
200-0424
imwel_field_area_c

mmade_line
200-0424
imwel_field_area_p

mmade_point
200-0424
imwel_field_area_p

mmade_point
200-0307
imwel_general_well_p

mmade_point
200-0307
imwel_general_well_p

mmade_centrd
200-0190
lfhyp_void_area_c

mmade_line
200-0435
lmfdc_levee_mainline_b

mmade_centrd
200-0435
lmfdc_levee_mainline_c

mmade_centrd
200-0420
lscnd_cemetery_c

mmade_line
200-0420
lscnd_cemetery_p

mmade_point
200-0420
lscnd_cemetery_p

mmade_centrd
200-0150
lscnd_land_use_c

mmade_centrd
200-0181
lscnd_land_use_c

mmade_centrd
200-0182
lscnd_land_use_c

mmade_centrd
200-0183
lscnd_land_use_c

mmade_centrd
200-0427
lsgen_mine_dump_c

mmade_line
200-0427
lsgen_mine_dump_p

mmade_point
200-0427
lsgen_mine_dump_p

mmade_centrd
200-0163
lsgen_mine_tailings_c

mmade_centrd
200-0428
lsgen_open_pit_mine_c

mmade_centrd
200-0432
lsgen_open_pit_mine_c

mmade_line
200-0428
lsgen_open_pit_mine_p

mmade_point
200-0428
lsgen_open_pit_mine_p

mmade_line
200-0432
lsgen_open_pit_mine_p

mmade_point
200-0432
lsgen_open_pit_mine_p

mmade_centrd
200-0429
lsgen_quarry_c

mmade_centrd
200-0429
lsgen_quarry_c

mmade_line
200-0429
lsgen_quarry_p

mmade_point
200-0429
lsgen_quarry_p

mmade_line
200-0429
lsgen_quarry_p

mmade_point
200-0429
lsgen_quarry_p

mmade_point
200-0609
lsgen_quarry_p

mmade_centrd
200-0430
lsgen_strip_mine_c

mmade_line
200-0430
lsgen_strip_mine_p

mmade_point
200-0430
lsgen_strip_mine_p

mmade_point
200-0303
lsgen_subsurface_mine_shaft_p

mmade_centrd
200-0184
mltng_range_live_fire_c

mmade_point
200-0629
trgen_navigation_light_p

mmade_line
200-0466
trhrb_breakwater_jetty_b

mmade_centrd
200-0466
trhrb_breakwater_jetty_c

mmade_point
200-0466
trhrb_breakwater_jetty_p

mmade_line
200-0465
trhrb_dolphin_p

mmade_point
200-0465
trhrb_dolphin_p

mmade_centrd
200-0465
trhrb_dolphin_p

mmade_line
200-0468
trnav_wreck_sunken_b

mmade_centrd
200-0468
trnav_wreck_sunken_c

mmade_point
200-0468
trnav_wreck_sunken_p

mmade_line
200-0467
trnav_wreck_visible_b

mmade_centrd
200-0467
trnav_wreck_visible_c

mmade_point
200-0467
trnav_wreck_visible_p

mmade_line
200-0201
trped_sidewalk_active_b

mmade_centrd
200-0165
utful_pump_p

mmade_centrd
200-0425
utgen_utility_tank_c

mmade_line
200-0425
utgen_utility_tank_p

mmade_point
200-0425
utgen_utility_tank_p

mmade_point
200-0314
utwat_intake_point_p

mmade_point
200-0604
utwat_tank_p

mmade_point
200-0617
utwwt_line_main_l

mmade_centrd
200-0421
utwwt_treat_plant_c

mmade_line
200-0421
utwwt_treat_plant_p

mmade_point
200-0421
utwwt_treat_plant_p

DLG Non-Vegetation

The DLG Non-Vegetation category contains information about non-vegetative areas. 
Feature Type
Major-Minor Code
MGE Feature Name

noveg_centrd
080-0104
getec_volcano_c

noveg_centrd
080-0101
hyczn_gravel_beach_area_c

noveg_centrd
080-0102
hyczn_sand_beach_area_c

noveg_centrd
080-0100
lftop_physiographic_area_c

DLG Pipeline

The DLG Pipeline category contains information about transmission pipelines. 

Feature Type
Major-Minor Code
MGE Feature Name

pipe_centrd
190-0406
bggen_structure_permanent_c

pipe_centrd
190-0408
bggen_structure_permanent_c

pipe_point
190-0406
bggen_structure_permanent_p

pipe_point
190-0408
bggen_structure_permanent_p

pipe_line
190-0203
cotel_cable_main_overhead_l

pipe_line
190-0209
imrec_ski_lift_l

pipe_centrd
190-0100
lfhyp_void_area_c

pipe_point
190-0405
lscnd_land_use_b

pipe_centrd
190-0405
lscnd_land_use_c

pipe_centrd
190-0404
trair_helipad_c

pipe_point
190-0404
trair_helipad_p

pipe_centrd
190-0403
trair_landing_strip_c

pipe_centrd
190-0403
trair_landing_strip_c

pipe_point
190-0403
trair_landing_strip_p

pipe_point
190-0403
trair_landing_strip_p

pipe_point
190-0602
trair_landing_strip_p

pipe_line
190-0601
trair_runway_centerline_l

pipe_point
190-0605
trair_runway_centerline_l

pipe_centrd
190-0410
trair_sea_plane_landing_area_c

pipe_point
190-0410
trair_sea_plane_landing_area_p

pipe_centrd
190-0409
trair_sea_plane_ramp_c

pipe_point
190-0409
trair_sea_plane_ramp_p

pipe_line
190-0207
trgen_tramway_l

pipe_line
190-0208
trrrd_monorail_l

pipe_line
190-0202
utele_cable_primary_oh_l

pipe_centrd
190-0402
utele_hydroelectric_plant_c

pipe_point
190-0402
utele_hydroelectric_plant_p

pipe_point
190-0606
utele_nuclear_plant_site_p

pipe_centrd
190-0400
utele_power_station_c

pipe_point
190-0400
utele_power_station_p

pipe_centrd
190-0401
utele_substation_c

pipe_point
190-0401
utele_substation_p

pipe_line
190-0201
utgen_pipeline_l

DLG Public Land Survey System

The DLG Public Land Survey System contains information about the Public Land Survey System. 
Feature Type
Major-Minor Code
MGE Feature Name

plss_centrd
301-
 cdpls_section_c

plss_centrd
300-0105
cdfed_interest_other_agreement_c

plss_point
300-0010
cdpls_ammended_monument_p

plss_point
300-0009
cdpls_angle_p

plss_point
300-0003
cdpls_closing_corner_p 

plss_centrd
300-0103
cdpls_land_grant_area_c

plss_centrd
300-0104
cdpls_land_grant_area_c

plss_point
300-0014
cdpls_landgrant_corner_p

plss_point
300-0004
cdpls_meander_corner_p

plss_point
300-0012
cdpls_quarter_corner_p

plss_centrd
300-0110
cdpls_range_line_l

plss_point
300-0001
cdpls_section_corner_p

plss_point
300-0015
cdpls_section_corner_p

plss_point
300-0301
cdpls_section_corner_p

plss_centrd
303-
cdpls_township_range_c

plss_centrd
304-
cdpls_township_range_c

plss_centrd
300-0111
cdpls_tract_area_c

plss_centrd
300-0199
cdpls_unsurveyed_area_c

plss_point
300-0007
cdpls_witness_corner_p

plss_point
300-0008
cdpls_witness_corner_p

plss_centrd
300-0113
cdtri_indian_allotment_c

plss_point
300-0300
gdsrv_control_point_min_loc_p

plss_centrd
300-0112
gesur_survey_area_c

plss_centrd
300-0198
hysur_water_body_permanent_c

DLG Road

The DLG Road category contains information about the road systems. 

Feature Type
Major-Minor Code
MGE Feature Name

road_point
170-0004
imgen_gate_p

road_centrd
170-0100
lfhyp_void_area_c

road_line
170-0606
trgen_road_ford_b

road_line
170-0601
trgen_tunnel_centerline_l

road_point
170-0002
trgen_tunnel_portal_p

road_line
170-0214
trmar_route_ferry_l

road_bdry
170-0214
trmar_route_ferry_l

road_line
170-0212
trped_trail_footbridge_active_b

road_bdry
170-0212
trped_trail_footbridge_active_b

road_line
170-0211
trped_trail_pedestrian_active_l

road_line
170-0212
trped_trail_pedestrian_active_l

road_line
170-0605
trped_trail_pedestrian_active_l

road_bdry
170-0211
trped_trail_pedestrian_active_l

road_bdry
170-0212
trped_trail_pedestrian_active_l

road_point
170-0001
trveh_bridge_abutment_p

road_point
170-0007
trveh_bridge_draw_c

road_line
170-0602
trveh_bridge_other_centerline_l

road_point
170-0005
trveh_cul_de_sac_l

road_line
170-0603
trveh_road_construction_b

road_centrd
170-0603
trveh_road_construction_c

road_line
170-0201
trveh_road_primary_centerline_l

road_line
170-0202
trveh_road_primary_centerline_l

road_line
170-0203
trveh_road_primary_centerline_l

road_line
170-0204
trveh_road_primary_centerline_l

road_line
170-0402
trveh_road_primary_centerline_l

road_line
170-0405
trveh_road_primary_centerline_l

road_line
170-0607
trveh_road_primary_centerline_l

road_line
170-0609
trveh_road_primary_centerline_l

road_bdry
170-0201
trveh_road_primary_centerline_l

road_bdry
170-0202
trveh_road_primary_centerline_l

road_bdry
170-0203
trveh_road_primary_centerline_l

road_bdry
170-0204
trveh_road_primary_centerline_l

road_line
170-0205
trveh_road_secondary_cenline_l

road_line
170-0206
trveh_road_secondary_cenline_l

road_line
170-0207
trveh_road_secondary_cenline_l

road_line
170-0208
trveh_road_secondary_cenline_l

road_line
170-0209
trveh_road_secondary_cenline_l

road_line
170-0210
trveh_road_secondary_cenline_l

road_line
170-0217
trveh_road_secondary_cenline_l

road_line
170-0218
trveh_road_secondary_cenline_l

road_line
170-0219
trveh_road_secondary_cenline_l

road_line
170-0221
trveh_road_secondary_cenline_l

road_line
170-0222
trveh_road_secondary_cenline_l

road_line
170-0223
trveh_road_secondary_cenline_l

road_line
170-0610
trveh_road_secondary_cenline_l

road_bdry
170-0205
trveh_road_secondary_cenline_l

road_bdry
170-0206
trveh_road_secondary_cenline_l

road_bdry
170-0207
trveh_road_secondary_cenline_l

road_bdry
170-0208
trveh_road_secondary_cenline_l

road_bdry
170-0209
trveh_road_secondary_cenline_l

road_bdry
170-0210
trveh_road_secondary_cenline_l

road_bdry
170-0217
trveh_road_secondary_cenline_l

road_bdry
170-0218
trveh_road_secondary_cenline_l

road_bdry
170-0219
trveh_road_secondary_cenline_l

road_bdry
170-0221
trveh_road_secondary_cenline_l

road_bdry
170-0222
trveh_road_secondary_cenline_l

road_bdry
170-0223
trveh_road_secondary_cenline_l

road_line
170-0403
trveh_tollgate_p

road_line
170-0401
trveh_traffic_circle_l

road_centrd
170-0404
trveh_weigh_station_c

road_point
170-0404
trveh_weigh_station_p

DLG Survey

The DLG Survey category contains survey and benchmark information.

Feature Type
Major-Minor Code
MGE Feature Name

svy_point
150-0301
gdsrv_control_point_3d_p

svy_point
150-0321
gdsrv_control_point_bd_notab_p

svy_point
150-0320
gdsrv_control_point_bd_tab_p

svy_point
150-0300
gdsrv_control_point_h3dp_p

svy_point
150-0303
gdsrv_control_point_horz_ele_p

svy_point
150-0311
gdsrv_control_point_v3dr_p

svy_point
150-0310
gdsrv_control_point_v3dt_p

svy_point
150-0302
gdsrv_control_vabm_p

DLG Vegetation

The DLG Vegetation category contains information about vegetative areas. 
Feature Type
Major-Minor Code
MGE Feature Name

veg_centrd
070-0101
flmgt_forest_stand_c

veg_centrd
070-0103
flprz_plantation_area_c

veg_centrd
070-0105
fltre_species_site_c

veg_centrd
070-0102
lscnd_land_cover_c

veg_centrd
070-0104
lscnd_land_use_c

Section 4. Workflow

The workflow described below allows the user to migrate the DLG data into an appropriate MGE design file.  The workflow corresponds to the migration flow chart presented in Section 2 of this document.  The numbers shown on the flowchart represent the task numbers in this section. 

Task 1.  SDS MGE PROJECT SETUP 

The migration of DLG data into MGE requires that an MGE project be created.  This MGE project should use a RIS Schema to link to the database.  The project should include all MGE applications, including the MGE DLG Translator.   
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Figure 2 Available MGE Applications

Once the MGE Project has been created and all system tables created through the Define Project Schema (TOOLS à BASIC ADMINISTRATOR à DEFINE PROJECT SCHEMA), use the RIS Batch program to run the Tables script created by the SDS/FMS Generator.  This will insert records into the Feature, Mscatalog, Category and Attribute_Catalog tables and will also build the empty attribute tables necessary to support the features added to the project.  The Domains script will build the populated domain tables.  The Relationships script will create the joins/relationships between the attribute and domain tables.  
Task 2.  MGE PROJECT MAINTENANCE

Once the MGE project has been created several tasks are necessary to allow the MDLG importer to migrate the DLG data into the MGE SDS formats.  This series of steps is designed to avoid the problem of trying to create features from multiple categories in the same file.  MGE has a restriction that features from multiple categories may not exist in the same file. In order to avoid the problem, the user will create a duplicate feature with the category value changed to a single value.  The features will then be linked to this table.  After all the processing is finished, the entity number for each element will be changed using a user command so that the features will be linked to the appropriate feature table. 
· Make a copy of the Feature table in the database.  Call it feat_dlg.  

Oracle

· Connect to Oracle using SQL Plus or SQL Worksheet.  

· Enter the following SQL statement. 

· Create table feat_dlg as select * from feature;

· Execute the statement.  A new table will be created that will be an exact copy of the feature table.

Access:

· Open the Access database.

· Click on the Tables tab.

· Click on the feature table.

· From the Access command menu, select Edit > Copy.

· From the Access command menu, select Edit > Paste.

· In the Paste Table As box, enter feat_dlg as the Table Name:  Make sure the button for Structure and Data is checked.  Select OK.

RIS

· Open the RIS Schema Manager by selecting Start > Programs > RIS 05.04 (or current version) > RIS Schema Manager from the Windows environment.

· Use the cursor and click on the name of the appropriate RIS Schema in the Schema Name section of the RIS Schema Manager form.

· Click on the Data Definition button on the RIS Schema Manager form. This will open the Data Definition form.

· Click on the Include button on the Data Definition form.  This will open the Include form.

· In the dbms Table Names section of the Include form, click on the feat_dlg tablename.

· Select Apply on the Include form.

· When the form says ‘Table feat_dlg included successfully’, close all the forms.

· Change the value in the category column of the feat_dlg table to a single value. This will put all the features into one category.  To do this, execute the following SQL command.  This can be done using the underlying database (Oracle, Access, etc.), or, if the MGE project is currently using RIS, the RIS Interactive tool can be used.

· update feat_dlg set category = 200001;

· Add the table feat_dlg into the mscatalog table.  This can be done by executing SQL commands below.  Use the underlying database or the RIS Interactive utility.

· Determine an appropriate entitynum for the feat_dlg table.  Execute the following command:

· select * from mscatalog where entitynum < 1000 order by entitynum; 

Use the lowest number that is not currently taken.  A number such as 15 will probably be available.

· Insert a record in the mscatalog table using the following command:

· insert into mscatalog (tablename, entitynum,nextocc) values (‘feat_dlg’, 15, 1); 

· Edit the project.tab file so that it points to feat_dlg as the feature table.  The project.tab file is a text file that may or may not exist in your MGE directory structure.  If it doesn’t, create one using a text editor.  Place the file in the main directory of your project, in the level just above the /dgn directory.  Add the following line:

feature:feat_dlg
Task 3. DLG ANALYSIS

This task is used to determine which feature codes exist in the DLGs to be translated.  By using these commands, the user can pare down the definition files that will be used later.  Features that are not present or are not desired will not be translated.  The user can also use these reports to check the quality of the translation to make sure all feature codes are accounted for.

· Use dlg_anl to output a report for each dlg to be translated. Optionally, use the analyze script to use dlg_anl on a set of files.  Dlg_anl is a command that is included with the MDLG product.  To use it:

· From MGE, select Utilities > Command Prompt.  A DOS window will open and the current directory will be set to the home directory of the active project.

· From the command prompt, change directories to the location of the DLGs that are to be analyzed.

· From the command line type dlganl –v –F <filename>.  A report of the feature codes that exist in the file will appear on the screen.  

· To have the analysis output to a report file, use dlganl –v –F <filename> -R <reportfilename>.  The report file will be placed in the /rpt directory of the project.

Optionally, the analyze.cmd script can be used to analyze a group of files.  Analyze.cmd is a perl script that uses the dir command to generate a list of files to be analyzed, then runs the dlganl command on them.  

· Open the analyze.cmd  file with notepad (or other text editor) and edit the line that begins:

open (DLG, "dir /B *.opt | ")

Everything between the /B and the | is the list of files that will be processed.  If the files end with a .dlg extension, for example, replace *.opt with *.dlg. 

· Close the file and type in analyze from the command prompt.  The report files will be placed in the /rpt directory of the project.

A sample report file is included below.  It is broken into three main sections.  

The first section contains the metadata information about the DLG.  This information includes the overlay name, scale, and projection information.  This information determines the type of seed file used and the type of parameter file to be used for the translation.

The second section includes the list of multiple feature code combinations.  Typically, these combinations will consist of a code and another code that is often a modifier or attribute.  An example of this would be boundary information that contains the State FIPS code.  

The third section gives a list of all the codes that are found within the DLG and their counts.  These are broken into Nodes, Areas, and Lines.  Typically, nodes are translated as point features, areas are translated into centroid features, and lines are translated into line features within MGE.  The bounding linework for areas may consist of line feature types AND area boundary feature types.  Within the DLG, there are line features that do not have associated feature codes.  When these are translated into MGE, they are turned into area boundary feature types.  The only way to associate a centroid with its bounding linework is by using MGE’s complexer routine, which will be done in a later step.

Header Information:

DLG File Type: Optional

Banner: USGS-NMD  DLG DATA - CHARACTER FORMAT - 09-29-87 VERSION 

Overlay name: BOUNDARIES

Level code:      3

Scale denominator: 100000

UTM zone code: 15

National Cartographic Unit: NEW ORLEANS, LA                         

Ground planimetric code: 1 (UTM)

Date of original source and revision: 1983,     

Revision date qualifier:  

Units of measure code:      2 (meters)

Number of nodes: 12

Number of areas: 5

Number of lines: 15

SW control point (lat/lon):    29.500000   -90.250000

NW control point (lat/lon):    29.750000   -90.250000

NE control point (lat/lon):    29.750000   -90.000000

SE control point (lat/lon):    29.500000   -90.000000

Unique Sets of Multiple Feature Codes:

Type  Feature Code Combination

----  ------------------------

 A    091-0022 092-0057      

    1 Occurrence(s)

 A    091-0022 092-0089      

    1 Occurrence(s)

 A    091-0022 092-0051      

    1 Occurrence(s)

 A    091-0022 092-0075      

    1 Occurrence(s)

 L    090-0201 099-0030      

    1 Occurrence(s)

Feature Code Counts:

No node feature codes exist in this DLG data file

Type   Feature Code   Count   Multiple Count  Single Count

----   ------------   -----   --------------  ------------

 A       000-0000        1           0              1

 A       091-0022        4           4              0

 A       092-0051        1           1              0

 A       092-0057        1           1              0

 A       092-0075        1           1              0

 A       092-0089        1           1              0

Type   Feature Code   Count   Multiple Count  Single Count

----   ------------   -----   --------------  ------------

 L       090-0201        5           1              4

 L       099-0030        2           1              1

Parse the report files to get a list of the codes that will be used. To get a list of all the feature codes that are used, all of the report files must be opened and read.  If there are many files, this may sometimes be laborious.  The DOS ‘find’ command can be used to extract just the lines that contain feature codes.  An example would be:

From the DOS prompt:


find “09” *.rpt 

This will return a list of all the feature codes in all the report files that begin with 09.

Edit the parameter files based on this information. There are two sets of parameter files.  One is used for the initial translation into MGE.  These parameter files will not need to be changed.  The *.def files are used when taking the translated data and feature tagging it properly.  Each time a set of maps will be translated, these files will need to be edited in order to save time.  

Editing Parameter Files 

· Select the appropriate parameter file based on the type of DLG.  For example, if the DLG category is Hydrography, select the dlghydro.def file to edit.

· Open the parameter file using a text editor.

· Delete the lines for all codes that are not present in the DLGs.  The DLG feature code is the fourth field in each line.  Compare it to the parsed reports to determine if that feature is present in the DLG.  Note that using the parameter files as-is will not harm the translation, but will result in a lot of error messages because the specified feature code cannot be found.  The output file will still be created successfully.

· Some features are represented by multiple element types.  Because of this, certain feature codes may be present two or three times.  This is to account for features that can be represented as centroids, area boundaries, or lines.  Typically these are codes whose minor code is in the 0400 range.

· Save the parameter file and close it.

Task 4.  DLG IMPORT

The import task is for the MDLG translator to actually turn the DLG into a design file.  The DLG data is output into a design file with the graphics in their correct geographic location and with default feature tags that are used by the system. 

A design file with the proper coordinate system must be used as a two-dimensional seed file.  This seed file can be used by ALL dlgs to be translated as long as they all have the same coordinate system and UTM zone, if appropriate. 
Be aware that typically DLGs of different scales may have different coordinate systems.  The dlgseed.dgn file has been included as a sample seed file.  In most cases it will need to be modified to fit the appropriate zone for translation.  To modify this seed file:

Modifying Coordinate System

· Open the dlgseed.dgn file by opening an MGE project and then selecting Map à Open..  and selecting the dlgseed.dgn file.

· From the MicroStation command menu select Applications à MGE Coordinate System Operations.
· From the MGE Coordinate Systems Operations menu, select File à Coordinate System à Primary.  The Define Primary Coordinate System form will appear as shown below:  
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Using the arrow on the right hand side of the System: box, select the appropriate coordinate system.

If the Coordinate System is Universal Transverse Mercator, select the Parameters… box to the right hand side of the System: box.  The System Parameters form will appear as shown below:  
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· On the System Parameters form, select the appropriate zone. 

· Select OK to dismiss the System Parameters box.

· Select OK to dismiss the Define Primary Coordinate System box.

· Select File > Exit to close the seed file.

DLG Translater

Run the dlg translator on the files, that are separated by category.  The input script can be used to translate a group of files.  To run the MDLG translator: 

Select the appropriate *.gpf file to use as a parameter file.  There is one *.gpf file present for each type of DLG.  The *.gpf files will force the translator to use default feature names and tables when writing the data to a map and the database.  In the next few steps, that data will be used to appropriately tag the features in accordance with the SDS/FMS.

Open an MGE command prompt.  Change directories to where the DLG data is stored.

The basic command line for translating one DLG is as follows:

dlgin – v –F <filename> -P <parameter file (*.gpf) > -D <output file name> -S <seedfile>

For example, if the DLG filename was no2.bdry.opt, the command might look like this:

dlgin – v  -F no2.bdry.opt –P bound.gpf –D boundary.dgn –S dlgseed.dgn

If a series of files from the same category are to be translated into one map, subsequent executions of the command will differ only in that they will not include the seed file parameter.  For example:

dlgin –v –F no3.bdry.opt –P bound.gpf –D boundary.dgn

It is recommended that an area that is composed of multiple DLGs of the same category all be appended to the same map.  This is not required, but it can make graphic cleanup easier.

The perl script input.cmd has been written to automate translation of a large number of files.  Before it can be run, it will need to be modified for the appropriate file names.  Open the script with a text editor such as Notepad.  Edit the line:

open (DLG, "dir /B *.opt | ")

Change the ‘dir’ statement to more accurately reflect the list of files that are to be translated.  This is the same ‘dir’ statement used in DOS.  Change the *.opt portion of the statement so that the appropriate files will be listed.  If all files are to be used, simply change the statement to:


dir /B *.* |  
Also, change the name of the parameter file on both lines that begin with dlgin.  This file will be the appropriate .gpf file for the specific category.  For example:  

dlgin -v -F $File -P rail.gpf -D $Outputfile 

Lastly, change the value of the seed file if it is named other than dlgseed.dgn.  

Save and close the script file.

To execute the command, copy it to the directory where the DLG files are stored and from the DOS command line type in:

input

Task 5.  DLG FEATURE MAKER

Run the dlgfmkr script to feature tag all the necessary features.  The dlgfmkr script is a modification of the blkfmkr script delivered with MGE.  It reads the parameter file, then runs the MGE command featmkr on all the elements that match a given query.  

A dlgfmkr parameter file is a text file with a series of lines that has 4 fields.  These fields are used to build a temporary list file that is passed to MGE’s feature maker process.  The fields are separated by colons (:).  The fields are, in order from left to right:

-
dlg feature table name:  this is the name of the attribute table the MDLG translator attaches to the element that will contain ALL of that element’s feature codes.

-
Feature code:  this is the name of the default feature code given to elements by the MDLG translator.  By default these elements are given names that are a combination of the DLG category (hydro, bdry, etc.) and the MGE feature type (point, centroid, line, or boundary).  

-
Value in the dall_fcodes field:  the dall_fcodes field is the column in the dlg feature table name where the translator stores all of the feature codes associated with a given element.  By searching this field, the script can extract elements that may be given two or more DLG feature codes and attach the appropriate SDS/FMS codes.

-
SDS/FMS feature name: this is the name of the feature within SDS/FMS that the element meeting the preceding criteria will be given.

The dlgfmkr processes each map file by reading each line within the parameter file, attempting to build a list of elements from the map meeting the criteria, then applying the appropriate SDS/FMS feature name.  When each line has been processed, a new map will be output that has the same name as the input file but with a .fea extension.  The resulting files will need to be renamed back to the .dgn extension after this task is completed.

To run the dlgfmkr script, copy the files dlgfmkr.pl and dlgfmkr.bat into the dgn directory of the project.  At least one *.def parameter file should be present.  Open an MGE command prompt window and change directories into the dgn directory.  From the command prompt, type:


dlgfmkr <*.def parameter file> <design file name>

For example:


dlgfmkr dlgroad.def no2road.dgn

In this example, the file no2road.fea will be output.

Task 6.  COMMON BOUNDARY CLEANUP

If more than one DLG has been appended to a single design file, the boundaries between the two DLGs need to be deleted. This will allow the Endpoint processor procedure to find and fix many dangling endpoints.  When these are fixed, elements that are broken at the edge of the DLG can be used to create complex areas without introducing artificial errors such as the DLG border.  

To delete the common boundaries:

· Open the design file in MGE.

· Place a fence around the common border, as closely as possible.

· Set the fence mode to Clip.

· Delete the fence contents.

· Repeat the procedure for all seams between DLGs.

· Compress the design file with the FILE à COMPRESS DESIGN menu option.

· Save the design file settings with the FILE à SAVE SETTINGS menu option.

Task 7.  GRAPHIC CLEANUP

The SDS/FMS data standards require that polygon features be included in the graphics where appropriate.  In order to assemble polygons within an MGE project, the line work that defines the boundaries of the polygons need to be topographically clean.  The three processes included in the Graphic Cleanup task - Intersection Processor, Duplicate Line Processor, and Endpoint Processor - allow the MGE user to verify that the line work will assemble polygons correctly.  

For each of the three cleanup routines, an approach using the MGE forms has been outlined.  A corresponding command file has been developed that runs each design file through the process.  In all cases, the command file uses the same options that are indicated in this document.  The command file is provided for users familiar with MGE functionality.

· Intersection Processor - Intersection Processor will search the map to discover any intersections that are not broken. In addition, it is simply good practice to ensure that lines break at intersections for topological reasons.

(Suggest changing phrase to a heading for more visibility)

To run Intersection Processor:

· From the MGE form select Map à Open and open a map.

· From the MicroStation command menu, select Applications à MGE Base Mapper.  The menu will change to the MGE Base Mapper menu.

· From the MGE Base Mapper menu, select Tools à Linework Processing… à Intersection Processor. The Intersection Processor form will appear as shown below:  
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· On the Intersection Processor form, input the name of the design file to be processed. 

· In the Output Design field, input the name of a file to be output.

· Click the Break Intersections option.

· Click the Options… button besides the Break Intersections option.  The Break Intersections form appears as shown below:  
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· In the Break Intersections box, input a number that represents a stroking tolerance.  A smaller number is better.

· Select OK to dismiss the Break Intersections form.

· Select OK, then Execute and Wait, and OK to begin the process.  The process will begin and output a new file.  Check the output design file to make sure lines are broken at their point of intersection.

Intersection Processor Command File - An alternative to the use of the MGE Intersection Processor interactive forms is to use the INTRSECT.CMD command file.  This command file will run all design files within the project’s DGN directory through the Intersection Processor with no user interaction.  The INTRSECT.CMD file uses the same settings shown on the MGE forms in this section of the document.

To use the INTRSECT.CMD file, open an MGE Command Window (UTILITIESà COMMAND WINDOW) and change directories to the dgn directory (cd dgn).  Once in the design file directory, issue the intersect command with the full path.  For example:  


D:/triservices/batch/intrsect 
Once started, the INTRSECT command file will process each design file in the directory in turn.  All error flags are put on level 63 of the design file.  Use the standard Microstation editing tools to correct any intersections not corrected by the software.  See Intersection Processor for form. 

· Duplicate Line Processor - Duplicate lines appear in DLGs and must be deleted.  A Duplicate Line is defined as two graphic elements being exactly coincident with the design file.  Duplicate lines can cause problems with building complex shapes.

To run Duplicate Line Processor:

· From the MGE form, select Map à Open and open a map.

· From the MicroStation command menu select Applications à MGE Base Mapper. The command menu changes to the MGE Base Mapper menu.

· From the MGE Base Mapper menu, select Tools à Linework Processing … à Duplicate Line Processor.  The Duplicate Line Processor form appears as shown below: 

[image: image7.png]ework Processor [[C1x]

Input DesigniList File:

Output Design File:

‘ ]

Merged Linework Level:

Stroking Tolerance and Unit: [ ]
oK | Apply Cancel





· Input the name of the current design file.  Make sure that it is the file output from any previous line cleaning steps.  

· Input the name of an output design file.

· Select OK,  Execute and Wait, and OK to execute the process.  All duplicate lines will be merged together on level 63.  This doesn’t matter because later processes will be selecting features based on their database attributes, not their graphic symbology.

Duplicate Line Processor Command File - An alternative to the using the MGE Duplicate Line Processor interactive forms is to use the DUPLINE.CMD command file.  This command file will run all design files within the project’s DGN directory through the Duplicate Line Processor with no user interaction.  The DUPLINE.CMD file uses the same settings shown on the MGE forms in this section of the document.

To use the DUPLINE.CMD file, open an MGE Command Window (UTILITIESà COMMAND WINDOW) and change directories to the design file directory (cd dgn).  Once in the design file directory, issue the intersect command with the full path.  For example: 


D:/triservices/batch/dupline
Once started, the DUPLINE command file will process each design file in the directory in turn.  All duplicate line work will be merged to level 63 of the design file.  Use the standard Microstation editing tools to move the correct duplicate line work merged onto level 63.  See Intersection Processor for form.  

· Endpoint Processor - The purpose of running endpoint processor is to try to resolve all the free endpoints that exist in the file.  Many free endpoints are acceptable.  These are mainly lines that simply end at a given point, such as the origin of a stream.  Other free endpoints are not acceptable.  Mainly this occurs along the edges of where 2 DLGs are joined.  When the boundaries are deleted, many lines remain along the edges to be joined.  Endpoint processor joins some of these lines automatically.  It flags the remainder for manual cleanup.

To run endpoint processor:

· From the MGE form, select Map à Open and open a map.

· From the MicroStation command menu, select Applications > MGE Base Mapper. The command menu changes to the MGE Base Mapper menu.

· From the MGE Base Mapper menu, select Tools > Linework Processing … > Endpoint Processor.  The Endpoint Processor form appears.

· Enter the name of the Input file.  Make sure it is the same as the output file from the last line processing process.

· Enter the name of an output file.

· Click the Fix Free Endpoints option.

· Click on the Options… button beside the Fix Free Endpoints option.  The Fix Free Endpoints form appears as shown below:

[image: image8.png]Fix Free Endpoints S 3

Tolerance ————
8
z

Stroking Tolerance: [

K{Bend Free Endpoints





· Enter 2 m as the starting X-Y tolerance value.  This is the distance of a box that will be drawn to determine if a free endpoint is close enough to another free endpoint.

· Enter 1 m as the starting Z tolerance value.

· Click the Bend Free Endpoints box.  This will allow MGE to bend lines where they cross the tolerance boxes so that they can be linked to another free endpoint.

· Select OK to exit the Fix Free Endpoints box.

· In the Unresolved Free Endpoints section, enter the name of a list file for storing all the endpoint flags for those endpoints that don’t get fixed.

· Select the Write Endpoint Flags option.  Make the level 63.

· Select OK, Execute and Wait, and OK.  The process will begin.  A new map will be output with corrected linework.

· Endpoint Processor Command File - An alternative to using the MGE Endpoint  Processor interactive forms is to use the ENDPOINT.CMD command file.  This command file will run all design files within the project’s design file directory through the Endpoint Processor with no user interaction.  The ENDPOINT.CMD file uses the same settings shown on the MGE forms in this section of the document.

To use the ENDPOINT.CMD file, open an MGE Command Window (UTILITIESà COMMAND WINDOW) and change directories to the design file directory (cd dgn).  Once in the design file directory, issue the endpoint command with the full path.  For example:  


D:/triservices/batch/endpoint
Once started, the ENDPOINT command file will process each design file in the directory in turn.  All Free endpoints will have an error flag show on level 63 of the design file.  Further, the MGE Basic Nucleus can be used to load the file’s Queue file.  This queue file can be used to quickly locate the outstanding free endpoints for correction.   To use the Basic Nucleus Queue, open the design file in MGE and start the Basic Nucleus.  The PALETTE à QUEUE menu option will open a toolbox for the queue file as shown below:  

[image: image9.png]



Using the queue toolbox, open the error list file in the projects ULF directory (XXXXXXXX_err.ulf).  Using the Queue toolbox’s Next, Current, and Previous buttons, step through each free end point location and if necessary correct the error.  Continue using the Next button to move through each error until all errors have been corrected.

Each Graphic Cleanup step (Intersection, Duplicate Line, and Endpoint) should be run as many times as necessary to have each design file run without error.  An iterative process should be expected during the Graphic Cleanup task.

Task 8.  FEATURE REPORTER

After the Graphic Cleanup task has been completed and all design files are topologically correct, use the MGE Feature Reporter tool to generate a list of all of the features within each design file.  This list of features will be required for the identification of files that contain boundary line work and centroids.  These features will be used to generate polygon features within the SDS/FMS design files that are created later in the workflow. 

· From the MGE form, select Tools > MGE Base Nucleus à Feature Reporter.  The Feature Reporter form appears as shown below: 
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· Enter the name of the design file to be analyzed.

· Click the Summary button.

· The report may either be output to the screen, to a report file, or to both.  For most applications, reporting to the screen will be sufficient.

· Select OK to begin the process.

· The process list will appear and state that the process has executed successfully.

· If the report destination is to the screen, a DOS window will appear with information similar to the following:
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Using the report, decide which design files contain boundary and centroid features.  These files will need to be processed through Tasks 9 and 10. The Feature report can also be used to quality control the design files.  If any features are in the design file without a feature tag, they will need to be identified and tagged before continuing the process. 

· Feature Reporter Command File – Similar to the Graphics Cleanup command files, the REPORTER.CMD file runs each design file in the projects design file directory through the MGE Feature Reporter.  Instead of displaying the results on screen, a file is generated for each design file in the projects RPT directory.  These files can be viewed and printed with Notepad.

Task 9.  DGN BUILD (BOUNDARY/CENTROIDS)

For the design files that were identified as having Boundary and Centroid features, a design file containing only the Boundary and Centroid features needs to be created.  This temporary file will be used in Task 10 to generate polygons from the boundaries and centroids.  These polygons will be linked to the attribute records of the centroids and will be topologically clean. 

· Use the DGN Maker process within MGE Base Mapper to select the area (boundary and centroid) features and output them to a new file.

· From the MGE form, select Map à Open and open a map.

· From the MicroStation command menu, select Applications à MGE Base Mapper.  The command menu will change.

· From the MGE Base Mapper command menu select Tools > Graphics Processing… > DGN Maker… The DGN Maker form will appear as shown below:
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· Select the most recently edited design file as the Input Design/List File.

· Click on the Build ULF… button.  The ULF Builder form appears as shown below: 

[image: image13.jpg][T

Design File:
A \sdsfull\dgn\bdjur_no.dgn

[~ Element Criteria

Cell:

[ Feature Criteria
Fore I djur_district leves b A
£ djur_district levee o =

oK Reset Cancel





· On the ULF Builder form, click on the Feature… button.  The Select Feature form appears.

· On the Select Feature form, select the appropriate boundary and centroid features.  This will change based on the category of dlg you have translated in.  For example, for boundary features, the name would be bdjur_district_levee_b and bdjur_district_levee_c.  This information can be found by using the Feature/Attribute Manager command in MGE Base Mapper and looking at the feature tags for each element.

· Select the appropriate features and click the OK button to dismiss the Select Feature form.

· Select OK to dismiss the ULF Builder form.

· Enter the name of an output design file on the DGN Maker form.  Select OK. Select the Execute and Wait button and select OK to begin the process.

· When the process is finished, check the new file to make sure there are only boundary and centroid features.

Task 10.  COMPLEXER (BOUNDARIES/CENTROIDS)

Complex the area files. The only way to maintain the geometry of an area defined in a DLG is to complex the areas.  To do this, use MGE’s Complexer command.

· Open the design file created in the previous step.

· From the MicroStation command menu, select Applications à MGE Base Mapper.  The MGE Base Mapper command menu appears.

· From the MGE Base Mapper command menu, select Tools à Graphics Processing… à Complexer …   The Complexer form appears as shown below:  
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· Enter the name of the file created from the previous step in the Input Design field.  This file should contain  ONLY the elements that are to be complexed.  For this reason, there is no reason to build a list file.

· Enter an output design file.

· Select OK, Execute and Wait and OK to begin the process.

When the process ends, check the output file.  The centroids should be gone, and replaced with shapes that have links to the centroid table.

Task 11. MERGE BOUNDARIES INTO LINES

Merge the areas back in with the lines and points.  Merging will put all the elements back into one single file.  To merge the files.

· Open the original file.

· Set the active level to 63.  This can be done by keying in: lv=63 in the MicroStation command menu.  If no Command Line is available within the Graphics environment, one can be created using the UTILITIES à KEY-IN menu option.

· Turn off all the levels in the file.  This can be done by keying in: of=1-63 in the MicroStation command menu, then placing the cursor in the current view(add comma) and clicking the left mouse button.  All the visible graphics should disappear.

· Reference the complexed file to the current file.  Make sure the complexed shapes are visible.

· Place a fence around the complex shapes.

· Set the fence mode to Overlap.

· On the MicroStation keyin box, key in fence copy.  You will be prompted to enter an origin.

· Place the cursor somewhere in the view and press the left mouse button.  You will then be prompted to enter a destination point.

· On the MicroStation keyin box, key in dx=0,0.  This will copy the elements from the reference file into the active file without shifting them in either the x or y direction.

· Detach the reference file.

· Turn on all levels.  This can be done by keying in: on=1-63 and placing a data point in the current view.  All graphic elements should appear.  If the shapes are missing, review the previous steps.

Task 12.  FEATURE REPORTER

Run Feature Reporter on the file to determine what features are present. This procedure will help to determine which features currently exist in the design file.  By running this process, no features will be overlooked.  This will give the user an idea of how many SDS/FMS maps will be created.  The first 5 letters of a SDS/FMS feature name identify its category.  Within MGE and SDS/FMS, each category must be given its own map.  By listing all the features within a file, a list of maps to be created can be generated.  To run feature reporter: 

· From the MGE form, select Tools > MGE Base Nucleus à Feature Reporter.  The Feature Reporter form appears as shown below: 
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· Enter the name of the design file to be analyzed.

· Click the Summary button.  The report may either be output to the screen, to a report file, or to both.  For most applications, reporting to the screen will be sufficient.

· Select OK to begin the process.  The process list will appear and state that the process has executed successfully.

If the report destination is to the screen, a DOS window will appear with information similar to the following: 
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The Feature report can also be used to quality control the design files.  If any features are in the design file without a feature tag, they will need to be identified and tagged before continuing the process. 

· Feature Reporter Command File – Similar to the Graphics Cleanup command files, the REPORTER.CMD file runs each design file in the project’s design file directory through the MGE Feature Reporter.  Instead of displaying the results on screen, a file is generated for each design file in the project’s RPT directory.  These files can be viewed and printed with a text editor.

Task 13.  ATTRIBUTE BULK UPDATING (OPTIONAL)

Update any attribute tables based on existing feature codes using Bulk update. In order to perform this process, the Bulk Update command must be running, using a list file to identify the features to be updated.  An example of how to do this follows:

· From the MGE form, select Tools > MGE Base Mapper à Attribute Processing … à Bulk Update.  The Bulk Update form appears as shown below:  
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· On the Bulk Update form, select the design file containing the elements to be updated.

· Click on the Build ULF button to bring up the Build ULF form.  

· On the Build ULF form, enter the name of the Table to be searched.  This will be the default DLG table created for this category.  It may be dlg_hydro, dlg_mmade, etc.

· In the Query field, enter the SQL query to select the appropriate DLG fcodes from the dall_fcodes table.  For example, to update the fields for a building that is a stadium, enter the following query:

select dlg_mmade.mslink from dlg_mmade were dall_fcodes like '%200-0456%'

This will select only those graphic elements with an fcode indicating that they are stadiums.

· Select OK to dismiss the ULF Builder form.

· On the Bulk Update form, select the tablename that will be updated.  In the example above, the tablename would be bggenstr. The columns of that table appear on the left hand side of the box below.

· In the Updated Values portion of the box, input the value to be updated for each field that will be updated.  For example, the value STADIUM will be put in the str_use_d field.

· Select the OK and execute the command.  The values will be updated in the table.

This Attribute Bulk Updating depends upon the ability to identify attributes to be updated for multiple graphic records.  It is not required for successful completion of the DLG to MGE SDS/FMS data migration process.

Task 14. LINKAGE DETACHER

Run linkage detacher to remove the temporary feature tags that were assigned by the dlgin process.  These feature tags were temporary and used by the DLG Feature Maker process to assign the correct feature tag.  Once the features have been linked to their appropriate SDS/FMS feature linkages and all desired attributes have been updated, it is not necessary to maintain the original codes from DLG.  

These temporary feature tags may be deleted using MGE’s Linkage Detacher command.  To detach these linkages see the example as follows:  

· From the MGE form, select Map à Open and open a map.

· Using the Feature/Attribute Manager command within MGE Base Mapper, identify the feature names and attribute tables to be deleted from the file.  Typically these will be the default names assigned to a particular DLG category.  For example, for the roads category the following feature names would exist: 



road boundary



road centroid



road line



road point

And the following DLG attribute table would exist:


dlg_road

· From the MicroStation command menu, select Applications à MGE Base Mapper.  The command menu will change to the MGE Base Mapper menu.

· From the MGE Base Mapper menu, select Tools à Graphics Processing …  à Linkage Detacher.  The Linkage Detacher form will appear as shown below:
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· Enter the name of the design file to be processed.  

· Enter the name of the output file to be generated.

· Click on the Feature,..  button.  The Feature Linkages form appears as shown below:
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· Select the features to be detached and click on the Add > button to move them to the Selected Features section of the form.  Select OK to dismiss the form.

· From the Linkage Detacher form, select the Attribute… button.  The Attribute Linkages form will appear as shown below:
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· Select the attribute table to delete.  This table will begin with ‘dlg’.  Use the Add > button to add the table to the Selected Tables: section of the form. 

· Click on the box beside Delete Attribute Records from Selected Tables.  This will delete these records from the database.  Do not do this if you have further use for the information in the tables.

· Select OK to dismiss the Attribute Linkages form.

· On the Linkage Detacher form, select OK and execute the command.  A new file will be output with linkages stripped.

The detaching of the temporary linkages is simply a cleanup process.  These temporary Feature Tags will have no effect on successfully generating SDS/FMS compliant design files.

Task 15.  SDS MAP GENERATOR

Use the MGE DGN Maker process to create the design files in conformance with the SDS/FMS standards. By using the MGE DGN Maker process, a list file can be built of all the feature codes within a design file that belong to a specific SDS/FMS category.  This resulting list file can be used to generate a design file that contains ONLY features that belong to a single SDS/FMS category.  

This process will need to be done once for each feature that exists in each design file.  Use the output from Feature Reporter from Task 12 to determine which maps will have to be created.  To create a file using DGN Maker:

· From the MicroStation command menu, select Applications à MGE Base Mapper.  The command menu will change.

[image: image21.png]DGN Maker

Input DesigniList File:

[E:\pr3 \dlg\dgn\bdj_end. dgn

Output Design File:

[E-\pr3\dlg\dgn\bdj_area.dgn

o] [





· From the MGE Base Mapper command menu, select Tools > Graphics Processing… > DGN Maker… The DGN Maker form will appear.  

· Input the name of the design file to be segregated.

· Click on the Build ULF… button to open the Build ULF form.

· On the Build ULF form, click on the Feature button.  Select all the features that are in a common category. 

· Select OK to dismiss the Build ULF form.

· Enter the output design file name.  This should be a SDS/FMS-compliant name.  The first 5 characters should be the category abbreviation.  The last 3 digits are user defined and are to be used to describe the location of the data.

· Select OK and execute the command.  A design file with just the features from a given category will be created.  

· If there are features from other SDS/FMS categories in this design file, repeat this process for each category.

This process of separating the DLG design files into several design files in required by the SDS/FMS standards. MGE also requires that only data in a single entity class be stored in a design file.  

Task 16. FEATURE REPORTER

Run Feature Reporter on the file to determine what features are present. This procedure will help to determine which features currently exist in the design file.  By running this process, no features will be overlooked.  This process will give the user an idea of how many SDS/FMS maps will be created.  The first 5 letters of a SDS/FMS feature name identify its category.  Within MGE and SDS/FMS, each category must be given its own map.  By listing all the features within a file, a list of maps to be created can be generated.  To run feature reporter: 

· From the MGE form, select Tools > MGE Base Nucleus à Feature Reporter.  The Feature Reporter form appears as shown below:  
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· Enter the name of the design file to be analyzed.

· Click the Summary button. The report may either be output to the screen, to a report file, or to both.  For most applications, reporting to the screen will be sufficient.

· Select OK to begin the process.

· The process list will appear and state that the process has executed successfully.  If the report destination is to the screen, a DOS window will appear with information similar to the following as shown below:
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· Feature Reporter Command File – Similar to the Graphics Cleanup command files, the REPORTER.CMD file runs each design file in the project’s design file directory through the MGE Feature Reporter.  Instead of displaying the results on screen, a file is generated for each design file in the projects RPT directory.  These files can be viewed and printed with Notepad.

Note the features that are present.  If there are features that belong in another entity class, they must have those linkages detached.  This final Feature Reporter is intended to provide a final quality control step to assure that only elements of a single MGE entity class are contained in the design file.

Run linkage detacher to detach inappropriate linkages from features in final files.  This step is used whenever an inappropriate feature linkage is found on an element in a SDS/FMS design file.  This linkage can occur on elements that have multiple feature linkages that are in differing categories.  After running the Feature Reporter step above to discover these problems, use the following steps to detach the inappropriate linkages.

Task 17. FEATURE CHECK (QUALITY CONTROL)

It is recommended that a final MGE Feature Check process is run against the MGE project to assure that all of the graphic elements within the project are feature tagged properly.  

· From the MGE form, select Tools > MGE Base Mapper à Data Validation… à Feature Check.  The Feature Reporter form appears as shown below:  
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· Browse for a design file within the project design file directory.

· Provide a List File name.  This file will contain a list of all features that have problems to be corrected.

· Choose to run all checks except number 7 - Features that are in the wrong Category.  Because the Feature table is currently replaced with the feat_dlg table and all features have been set to the same category value, this check will result in meaningless data.

· Hit the OK button to run the Feature Check.

Once the feature check completes, use the Basic Nucleus Queue to visit and correct each element with problems in the design file.  After all files have run through the Feature Check process cleanly, continue to Task 18.

Task 18.  RECORD CHECK (QUALITY CONTROL)

It is recommended that a MGE Record Check be run against the MAPS table to eliminate all design files created as part of the process of migration.  All tasks where a temporary design file was created will cause a new entry into the MAPS table.  The MGE Record Check will allow the user to remove these extra records.

Task 19.  MGE PROJECT MAINTENANCE

Once Task 18 has been completed, the DLG data has been successfully migrated into MGE SDS/FMS format.  All of the data validation checks have been completed and passed.  This task will undo the work-arounds that were put in place in Task 2 to allow the MGE DLG Translator to process the DLG data into SDS/FMS format.  The feature table will be reinstated, the feat_dlg table will be removed from the project, and the PROJECT .TAB file will be returned to referencing the FFEATURE table.

Run the chngent.ucm to change the entity number of the files so that they point to the feature table and not feat_dlg.  To this point, all the processing has been done using the copy of the feature table created in the setup steps.  This table was created to avoid the problem of features from different categories being placed in the same file.  Once the features have been separated into their appropriate maps, this table is no longer necessary.  The chngent.ucm is a user command that will change the entity number on each graphic element so that it will point to the feature table and not feat_dlg. 

· Using RIS Interactive, or the underlying database, search the mscatalog table to find the entity number for the feature table AND feat_dlg.  An SQL statement for this would be:

select tablename, entitynum from mscatalog where tablename like ‘feat%’

This should list both tables.  Write down the entitynum value for both.

· Using MGE, open a map containing elements that need to be fixed.

· From the MicroStation command menu, key in:

uc=d:\prj\dlg\data\chngent.ucm      

(use the appropriate directory path for your system)

· The user will be prompted to Enter the entity number to change.  Enter the entity number for the feat_dlg table.

· The user will then be prompted to Enter new number.  Enter the entity number for the feature table.

· The user commands will then process all features in the file and change those whose entity number meets the criteria.

Note that the command will work, but will not provide valid feature linkages until the project.tab file has been changed back to its original state and the project re-initialized. 

Edit the project.tab file to point the feature table back to ‘feature’ instead of feat_dlg.  Editing or deleting this file will force the MGE project to read the default feature table instead of the copy created in early steps.  To do this, open the project.tab file with a text editor.  Change the file back to its original state.  The line that begins with feature: should now read:

feature:feature

If there was no project.tab file initially, then this file can simply be deleted.

Task 20.  FINAL DELIVERY OF SDS DATA

This completes the migration of the DLG data into MGE SDS/FMS format.  This data can now be used for its intended purpose using the GIS analysis tools present in the Modular GIS Environment.  

Appendix A

This file describes the contents of the SDSFULL directory.  This directory contains the MGE project files created by the migration of USGS DLG files into an MGE GIS Project.  The Migration workflow used is included in a subdirectory on this disk.

SDSFULL - The root project directory.  This directory contains all of the system, support, design and document files.

SDSFULL\BATCH - This directory contains all of the batch files used in the migration process.  Several subdirectories are included:


DLGINGPFS - This subdirectory contains the GPF files necessary to control the initial DLGIN import 


process.


SAMPLE_DLGINS - This subdirectory contains sample batch scripts for importing several category based 


DLG files into a single DGN file.


SEEDFILE - This subdirectory contains the MicroStation seed file used for the MGE Project.


ZIPFILES - This subdirectory contains the batch/command files created as part the initial import process.

SDSFULL\CFG - The MGE Project Configuration directory.  No work was conducted in this directory as part of the migration.

SDSFULL\CMD - The MGE Project Command directory.  No work was conducted in this directory as part of the migration.

SDSFULL\MANUAL - This directory contains the updated DLG to MGE migration workflow.  The workflow is included in both Microsoft Word 97 and Adobe Acrobat Reader format.

SDSFULL\DATA - This directory contains a RIS Dump of the Project Schema.

SDSFULL\DGN - This directory contains all of the resulting MGE Design Files is SDS FMS format.  These files contain the graphics separated by SDS FMS features.  There are two subdirectories in this directory that have been included for clarification.


DEFFILES - This subdirectory contains all of the Definition files used by the DLG Bulk Feature Maker 


process.  These files will need to be moved into the Project DGN directory if DLG Feature Maker is being 


run.


MIGRATEDDGNS - This directory contains the DGN Files resulting from the DLG Import.  These files 


contain the data up to the point that the separate SDS FMS compliant Design Files are created.

SDSFULL\DLGDATA - This directory contains the DLG Files received from the USGS as source files.  These files are in the USGS DLG format (OPT Files).  The files have been separated into several subdirectories by 100K map sheet and category.

SDSFULL\FENCE - This is the MGE Project Fence Processing Directory.  No work was conducted in this directory as part of the migration.

SDSFULL\GRD - This is the MGE Project Grid Processing directory.  No work was conducted in this directory as part of the migration.

SDSFULL\IDX - This is the MGE Project Index Directory.  No index shape file was created as part of this project.

SDSFULL\EXPORT - This directory contains an MGE Export file of the entire MGE Project as it stands at the completion of the Migration workflow.  This file can be used to recreate the MGE Project using the MGE Import Process.

SDSFULL\QRY - This is the MGE Project Query Directory.  No work was conducted in this directory as part of the migration.

SDSFULL\RPT - This is the MGE Project Report Directory.  Several reports were generated as a part of this project, but were used for Quality Control and have been deleted as part of project cleanup.

SDSFULL\SEED - This is the MGE Project Seed Directory.  This directory contains the MGE Project Seed File.  This file places the graphics created by the import process in the correct coordinate space.

SDSFULL\SETUP - This is the MGE Project Setup directory.  No work was conducted in this directory as part of the migration.

SDSFULL\TOPO - This is the MGE Project Topology directory.  No work was conducted in this directory as part of the migration.

SDSFULL\TTN - This is the MGE Project TTN directory.  No work was conducted in this directory as part of the migration.

SDSFULL\ULF - This is the MGE Project Universal List File directory.  As part of the migration process, several files were created in this directory, but were used strictly for processing.  These files have been deleted as part of the project cleanup.

PROJECT.TAB - This file controls the way that MGE attaches to the project database.

Appendix B

MGE Spatial Data Transfer Standards Document Reference List

MGE Basic Administrator (MGAD) User’s Guide – Software Users Manual, 1997 Intergraph Corporation

MGE Base Mapper (MGMAP) User’s Guide – Software Users Manual, 1997 Intergraph Corporation

MGE Analyst (MGA)User’s Guide for the Windows NT Operating System – Software Users Manual, 1994 Intergraph Corporation

MGE Basic Nucleus (MGNUC) User’s Guide – Software Users Manual, 1997 Intergraph Corporation 

RIS Utilities Guide for 32-Bit Applications – Software Users Manual, 1996 Intergraph Corporation

RIS SQL Users’ Guide for 32-Bit Applications – Software Users Manual, 1996 Intergraph Corporation

Appendix C

MGE Spatial Data Transfer Standards Software Pricing

Software
Price
Notes

RIS Oracle Data Server
$220


MGE Base Administrator
$4000


MGE Base Mapper
$3000
part of MGE Bundle – not sold separately

MGE Basic Nucleus
$2000


MGE Analyst
$5000
part of MGE Bundle – not sold separately

MGE DLG Translator
No Charge
Available at http://www.intergraph.com/gis/new_free.asp

MicroStation
$4795
MicroStation J

_1042286401.doc
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